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Introduction 
SignStream® is available for download from https://www.bu.edu/asllrp/SignStream/3/.  Version 3.5.0 is a 
major upgrade, with important bug fixes and major new features.  All SignStream® users are urged to upgrade. 

System Requirements  
Operating Systems: MacOS Sonoma (14), MacOS Ventura (13), Monterey (12), Big Sur (11), Catalina (10.15), 
or Mojave (10.14).  SignStream® 3.5.0 may also work on older versions of the MacOS. 

Hardware: 
• Mac computer with 64-bit Intel or ARM (Apple Silicon) processor

o If you decide to use SignStream® 3.5.0 with the ARM processor: When you double-click on 
SignStream® for the first time--after following all installation instructions very carefully--you will 
be asked to install Rosetta (which emulates the Intel instruction set) if it is not already installed. 
You can then double-click on SignStream again to launch it.

• 2 GB of RAM
• 250 MB of hard drive space

Installation Instructions 
Please follow the directions carefully.  If you are not upgrading from a previous version, you can skip ahead to 
Section 1.3. 

1.1. Upgrading from SignStream® version 3.4.0 or 3.4.1 
You have two options: 
• You can upgrade using the “Upgrade SignStream” command from the Help menu in SignStream. This

preserves local information about annotators and participants, as well as all entries in the local Sign Bank.
• Alternatively, you can follow the instructions in the Section 1.2.

1.2. Upgrading from a prior version of SignStream®
You should download version 3.5.0 from the main SignStream 3 download page (as explained in Section 1.3). 
You can then manually copy over local files from your previous SignStream folder, as explained in Section 3.4, 
if you wish to preserve previous information about local annotators or participants, and/or entries from a local 
Sign Bank, before you launch the new application. 

Important note:  SignStream files that were last saved in a version of SignStream 3 prior to 3.3.0 cannot 
be opened with this current version of SignStream (3.5.0).  To open such files, you will need to first open 
them with SignStream version 3.3.0 and save them; those saved versions will then be able to be opened 
with the current version of SignStream.  If you do not have SignStream version 3.3.0 installed and need a 
link to download that version of the software for this purpose, please email Carol Neidle (carol@bu.edu) 
for a download link.  (System requirements for version 3.3.0 will be detailed in the email reply.) 

1.3. Installing a fresh new current version of SignStream® (version 3.5.0) 
The application is available for download from: http://www.bu.edu/asllrp/SignStream/3/download-
newSS.html. Unzip the "SignStream3-latest.zip" file that will have been downloaded. That will create a folder 
called "SignStream3". You can move the whole folder to your desired location, but do not move files within 
that folder. Before launching the application, you must complete the steps outlined below.  

Before launching the application, from within that folder: 
1) You will need to allow the launch of the SignStream®3 application, despite the fact that it is not

provided by Apple or certified developers (to get around security features that have been
implemented in Mac Operating Systems since OS 8).
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2) You will also be offered the opportunity to download the latest ASLLRP Global Sign Bank, which 
consists of a repertoire of signs, with gloss labels and annotations of other properties, as well as images 
and video illustration of those signs, to assist with annotation of new video files. This Global Sign Bank 
is not required for use of SignStream®. However, if you download the Sign Bank, you must agree to 
the terms of use below (which will also be downloaded to your SignStream folder). 

Open a Finder window, and double-click on the SignStream folder (the folder you downloaded, which 
includes the application and related files). Do the following, in the order listed: 

1)  [Required]   You will see a file called “DisableQuarantine.command”. Double-click on that. You may get 
a message asking if you want to open the file even though it is from an unidentified developer. If so, say YES. 
If you get a message that the file cannot be opened because it is from an unidentified developer: 

  a. Go into System Preferences > Security & Privacy > General 

  b. Under the section "Allow apps downloaded from" click "Open Anyway" for this file.   
      This will open in the Terminal application and run immediately, then close itself when finished. 

2) [Optional] If you wish to download the ASLLRP Global Sign Bank, double-click on 
"GetSignBank.command". You will be asked whether you wish to download the Sign Bank and agree to abide 
by the terms of use. If you click ‘yes’, the download of the ASLLRP Sign Bank materials (and Sign Bank terms 
of use) will commence.  Close the Terminal Window.  

Note: It is extremely important to be using the most current version of the global Sign Bank.  
New versions of the Sign Bank will be released in the future, and SignStream® will download  
new versions as they become available (alerting the user that this is to happen; see next section). 

Do not move files out of the main SignStream 3 folder.  

You will then be ready to launch SignStream® by double-clicking on the "SignStream3" file. You can skip 
ahead to Section 3.5 unless you have previously used an older version of the software and wish to preserve 
information from that version, in which case you should follow the instructions in Section 3.4 before launching 
SignStream®. 

1.4. If you do a fresh install of SignStream® 3.5.0, as explained in Section 1.3, and wish to manually 
copy local files from a prior SignStream® folder:   

 

You should follow the instructions in Section 1.3, but be 
careful to deploy the new package to a new directory distinct 
from any previous SignStream directory. Then copy the 
following files over from your old directory to the new 
SignStream directory (see Figure 1) to overwrite the previous 
files:  
signbank/localSignBank.xml  
newXMLfiles/localAnnotators.xml  
newXMLfiles/localParticipants.xml  
  
 
 
 
 

Figure 1. Local files to be preserved from older versions of SignStream® 

1.5. Note about installing SignStream® on ARM hardware 
The first time you click on the SignStream® application on ARM hardware, you will be asked to install Rosetta 
(which emulates the Intel instruction set) if it is not already installed. Click "Install" if asked. Once that is done, 
double-click again on the SignStream® application to launch it. 
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Change in File Format 
Starting with version 3.4.0, SignStream® files are saved with .ssc (rather than .ss3) as the file extension. One 
consequence of the change in file structure relative to earlier versions is that when you initially open a 
SignStream collection created with an earlier version of the application, a conversion to the new file format 
will occur, and the file will then subsequently be saved with the new file extension: .ssc.  It will no longer be 
possible to open .ssc files with earlier versions of SignStream.  The conversion process will also entail a file 
validation process, so please be patient while this occurs.  In the event that some intervention is required by 
the user to ensure that the data are properly converted, such validation errors will appear in a separate 
window, and instructions will be provided for verifying/correcting the relevant item. You can access any such 
messages (if you are alerted that there were any issues) from the Help menu, as shown in Figure 2. 

 
Figure 2. Any issues with the file can be viewed from the Help menu 

New Features in SignStream® 3.5  
1.6. Video-based Sign Bank Lookup 

SignStream version 3 includes the ability to install the Global Sign Bank, subject to terms of use, and to search 
for signs—allowing users to then enter gloss information and features of the selected sign. Alternatively, or in 
addition, users can create a local Sign Bank.  Choosing to “Add to Sign Bank” will add a new sign only to the 
local Sign Bank. The search functions described in Section � operate on anything that is in either Sign Bank.  
However, what is described in that section refers specifically to the data provided in the Global Sign Bank. 
Furthermore, the new video search, described in Section � works only for the Global Sign Bank. 

• Options that have been available in SignStream® 3 for using and searching the Global Sign Bank 

The Global Sign Bank accessible within SignStream® includes lexical signs, numbers, loan signs, and index signs; 
and searches can be based on characters in the gloss and/or hand information, as shown in Figure 3. 

 

Figure 3. Options for Searching the Sign Bank 

The user can view the example video for signs they select, as well as looking at other occurrences (and 
containing utterances, where appropriate) to confirm the sign of interest; the user can then automatically enter 
the sign gloss and some other features, as shown in Figure 4. The user can “Insert All Data,” which results in 
the Morph-Phon Window looking as in Figure 5, with gloss, start/end handshapes, as well as other properties 
as shown. The user can further edit, if necessary, after which the information can be entered, as usual, into the 
Utterance Window (by clicking the Enter button at the bottom of Figure 5. 
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Figure 4. Sign Bank Lookup - followed by "insert all data" (see result in next figure) 

 
 

           
 
 
 
 
 
 

 

Figure 5. Result of "insert all data" (further editing is possible);  
this can then be entered into the Utterance Window 

A few limitations to note:  
(1) Fingerspelled signs, classifiers, and gestures cannot be entered via the Sign Bank within SignStream®.  The 

user can consult the online Sign Bank < https://dai.cs.rutgers.edu/dai/s/signbank> to look up classifiers 
and gestures, although the list of such signs contained in the online Sign Bank is far from comprehensive.  

(2) If there are other handshapes in between the first and last, as for loan signs, these must be entered 
manually by the user. 

(3) Compounds cannot be entered directly via the Sign Bank.  In order to enter a compound, the component 
parts need to be entered separately, and then the compound is created in the Utterance Window by joining 
the component parts. For example, the compound MOTHER+FATHER would be annotated by entering each 
of the parts separately, as shown below. The compound parts are shown in the Sign Bank, with an asterisk 
representing the point of connection with the rest of the compound, as, e.g.: 

 MOTHER* (MOTHER+FATHER) 
 *FATHER  (MOTHER+FATHER) 

This is illustrated in Figure 6. 

1 

2 

3 
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Figure 6. Entering parts of a compound independently 

The whole compound will play when the user selects any of these buttons: 

 

However, you will notice that the “Insert All Data” button is grayed out and unavailable for compound parts. 
To enter the compound part directly, the user must select the independent sign occurrence, e.g. MOTHER, as 
shown in Figure 7. 

 
Figure 7. Inserting the first sign contained in that compound 

Once both/all compound parts have been entered independently, they can be linked in the Utterance Window 
to form a compound, using the contextual menu, as illustrated in Figure 8. 
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Figure 8. Linking signs in the Utterance Window (via the contextual menu) to create a compound 

For further information about using the SignStream Sign Bank, see Report No. 16 listed in Section 0. 

• NEW:  Lookup by Video Example  

How it works.  The newest version of SignStream® allows another option for looking up a sign and 
automatically entering associated information: selecting “DAI Video Search,” as shown in Figure 9. 

   
 

The SignStream user opens the Morph-Phon Window and selects “DAI Video Search.”  
If there is more than one video associated with the SignStream file, the user will be  
asked to select which video to use for the search. Best results will be obtained  
when the video is front-facing and includes a clear view of the signer's hands 

 

 
Figure 9. Brand New Search-by-video-example feature within SignStream® 

The user will then be presented with the 5 most likely matches for the submitted video, as shown in Figure 10. 

Utterance Window 

Morph-Phon Window 
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Figure 10. Potential Matches Offered to the User, in Decreasing Order of Likelihood 

 

                              When the user confirms the selection, this window appears: 

 
 

                              The user will then see a message like this: 

 

 

 

                              Upon confirmation, the relevant information is inserted, e.g.: 

 

 

 

 

 

 

                                                                                                                                               

 
 

 

Figure 11. Entering Information from the Video Search Results 
 

MORE 
MORE 
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The user can further edit, if necessary, before entering the information into the Utterance Window. 

If the user does not select one of 5 options within 5 minutes, or if the user chooses NONE of the options, 
the user will be told: “you can try using the "Search Sign Bank" button in the Morph-Phon Window, or you can 
try other ways of searching the DAI from http://dai.cs.rutgers.edu/dai/s/signbank.” 

Sometimes the selected sign may have more than one similar variant.  In that case, the user will be offered 
the opportunity to make a secondary selection. For example, the sign SECRETARY also has a variant with a U/H 
handshape on the dominant hand.  In such a case, the user will be asked to select the desired variant, as shown 
in Figure 12, which will then be entered into SignStream. 

(1)  
 

(2)  

Figure 12. Two-step Selection Process if the Selected Sign has Variants 
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Some limitations. The same limitations listed at the beginning of this section (p. 4) apply as to and the 
information that is automatically entered and the types of signs that can be searched in this way. However, in 
addition, Index signs cannot be entered via video lookup.  They are listed in the Sign Bank and can be entered 
via the non-video options for Sign Bank lookup, but since contextual information is essential to determining 
the appropriate gloss, these are not included for video-based searching. 

The recognized sign should *not* come back as a compound, since the user should not have chosen an 
entire compound as a single sign for annotation in the Morph-Phon Window.  If the selected sign is a 
compound, the user will be directed enter the component parts of the compound as separate signs.  The user 
will receive a message like the one shown in Figure 13. 

You selected the sign: <HAIR+DYE> It cannot be successfully entered directly into SignStream. 
 
The DAI returned a compound as the result. 

 
Solution: You will need to enter the gloss for each part individually and then combine them to 
form a compound in the Utterance Window. You may be able to find the compound parts 
separately in the Sign Bank (by clicking on Search Sign Bank) to facilitate data entry;  however, if 
the sign exists in the Sign Bank only as part of a compound, the gloss will appear with an asterisk 
before or after the text of the gloss, and you will not be able to automatically enter the information 
from that sign. You will then need to enter the information manually. 

Figure 13. Error Message if the Sign Returned is a Compound (which cannot be entered directly) 
1.7. NEW:  Gesture Mode 

Please see the Appendix for a detailed description J  

Changes in version 3.5.0 relative to 3.4.1  
§ This release now works with MacOS 14. 
§ There is an entirely new data type known as Gestures. These can be optionally edited in a separate 

view; it is possible to view both Sign and Gesture mode in the same window. 
§ Gesture mode works similarly to Sign mode, with some notable differences: 

o Palm and fingertip orientation information can now be linked to handshapes for gestures. 
o Gesture mode includes an additional handshape palette with handshapes deemed 

particularly useful for gesture research. 
o The mechanism for entry of gestures is a bit different from how this is done for signs; and 

there are several options for labeling gestures. 
o Gesture phases can be appended to the core gesture events, much as initial and final holds 

and onsets and offsets can be appended to sign events. 
o Gestures can also be associated with other optional Properties, including movement type 

and semantic/pragmatic features. 
o The location tab for gestures now also has expanded functionality. 

§ The handshape palette view (for both Signs and Gestures) has been altered slightly in appearance. 
§ Sign video lookup, based on the ASLLRP Sign Bank, is now integrated into the SignStream®. Once the 

user has established the start and end point of the sign to be looked up, this  functionality can be 
accessed from the Morph-Phon Window; and, upon confirmation of the recognized sign, the user 
can automatically enter the associated information into the Morph-Phon Window (subject to any 
further editing by the user). 
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§ A glitch that occurred if the Morph-Phon Window was left open and then the user attempted to edit 
a different sign has been eliminated by forcing the Morph-Phon Window for one sign to be closed 
before proceeding to edit a different sign. 

§ The Utterance View panels for Nonmanual, Gloss and Gesture modes can be dynamically resized. 
The resizing will be persisted through opening and closing of a collection. 

§ A display glitch when going from Utterance to Database view has been resolved. 
§ Gloss translation field bugs have been resolved. In addition, translation fields now only display within 

the time bounds of the utterance with which it is associated. 
§ The Paste function now does work when doing a “Save-as” for a SignStream file; the previous issue 

related to this has been resolved. 
§ A previous glitch, whereby double-clicking on a nonmanual field label temporarily triggered the 

up/down arrow keys to move the highlighted nonmanual field label instead of moving to the 
previous/next utterance, has been resolved. 

§ The buttons that control the Field displays have been moved into the left-hand region, e.g.: 
 

               

Some remaining issues 
1.8. Use of the up and down arrow keys  

It was previously possible to use the up and down arrow keys to navigate to the previous or next utterance in 
the utterance index list on the left of the Utterance Window.  However, for some reason in the versions 3.4.0 
and 3.4.1, you may need to click once in the right area of the window (within the rectangle shown below) prior 
to using the arrow keys.  

 
Figure 14. To use arrow keys for navigation in Utterance Index on the left of the Utterance Window : 

 click first within the rectangle shown. 
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1.9. Useful Tip: To change the name of an utterance 

In Database view, click once on the line representing the Utterance.  It will be highlighted in red. Then, click 
near the left edge of that line, and hold the mouse button down until the text box appears, in which you can 
type the new Utterance name. Hit a carriage return to enter. 

1.  

2.  

3.  

4.  

Figure 15. How to Rename an Utterance 
1.10. Other known issues – to be resolved in future versions 
• Installation 

o Issues can arise when any directory on the path to your SignStream installation contains a quote character ( ' ) or 
a double quote character ( " ), so remove these characters from your directory names to avoid any problems.  

• Macro-Unit Settings 
o There is an inconsistency in how edits or additions to the local participant list are treated. 

• Database and Utterance Windows 
o Display glitch in the Utterance Window when entering gloss labels for more than one sign prior to setting the start 

and end points.  Setting the start and end points of one of those items may cause the other to be displayed in such 
a way that the text for both is overlapping.  Workaround: Align the text of the first gloss label before entering the 
next one.  

o If you hide the Utterance Window (how you do this depends on your Mac OS, e.g., by clicking on the title bar, in 
older OSs, or by clicking on the red button at the upper left of the window), the hidden window is not recoverable.  
You will need to Quit SignStream and reopen the utterance.  Although you will not have access to Save File through 
the menus (because the Utterance Window is hidden), when you quit the program, you will be given the option to 
save the file.  Be sure to save if you want to.  Workaround: Don’t hide the Utterance Window.  

o Note that closing the Utterance Window will quit the program. That also means that during a search, closing the 
window displaying an utterance from the search results will quit the program, with no option to open a new search 
result. Closing the main SignStream window at any point will also quit the program. 

o The icons for zoom locking/unlocking may be duplicated momentarily upon opening a new collection. 
o The Utterance Index on the left side of the Utterance View is inconsistent in its text highlighting, sometimes black 

text on blue background and sometimes white text on blue background. 
o In the Utterance view, editing a nonmanual field value by double-clicking it to open the field value selection list 

and selecting a value will result in the Utterance Index list on the left incorrectly highlighting only the selected 
utterance (in blue) while not highlighting the visible utterances (in gray).  
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o The green bar location is remembered when opening or creating a collection. When switching collections, the 
video will start at time zero, but the green line will remain in the middle where it was for a previously opened 
collection.  The position of the green bar is also remembered when a video file is replaced within a SignStream 
collection and re-displayed.  

• Having more than 1 Temporal Partition and/or Segment Tier visible in the Utterance Window 
o Utterance highlighting is not consistent when multiple segment tiers are showing in Utterance View. 

• Morph-Phon and Sign Bank Windows 
o Morph-Phon settings for a gloss can visually linger on the dialog window when opening up the Morph-Phon dialog 

again for a different gloss. 
o Morph-Phon Window "Enter" button behavior is not consistent in when it is enabled or disabled (requiring use of 

the Bypass Sign Bank button to enter data).  
o The Local Sign Bank does not ignore the + sign that can occur at the end of a gloss label to indicate reduplication. 

In the Global Sign Bank, GLOSS and GLOSS+ and GLOSS++ are grouped under a single entry: GLOSS.  In the Local 
Sign Bank, if you have GLOSS+ at the time you save to local Sign Bank, it will be entered as GLOSS+.  So, you may 
have both GLOSS and GLOSS+ in the local Sign Bank, although that will never occur in the Global Sign Bank.  
Workaround:  Since it is currently impossible to delete an entry from the Local Sign Bank, you should be careful 
not to include the + in the Morph-Phon Window at the time you choose to enter a new sign into the Local Sign 
Bank.  In any case, after you enter the information from the Sign Bank, you will want to adjust the gloss label to 
include +’s as needed, to reflect the repetitions that happen at the end of that occurrence of the sign.  

o Currently, when you “insert all data” from the Sign Bank: 
1. Only the start and end handshapes of the sign will be inserted into the Morph-Phon Window. In case 

there are additional handshapes, e.g., for a loan sign, you will need to add them manually. 
2. There may be errors in the insertion of information about sign properties when entered 

automatically from the Sign Bank (especially in regard to sign type for name signs that have a prefix 
before the ns- marking, e.g., “(M)ns-text” or “(2h)ns-text)”). Please be sure to verify that all 
information about sign properties displayed in the Morph-Phon Window is correct before entering 
that information into the Utterance Window.  

• Searching 
o In versions 3.4.0, 3.4.1, and 3.5.0, it is no longer possible to change the search domain, and thus no longer possible 

to carry out the same search on more than one SignStream collection.  
• Other 

o For some reason, launching SignStream® causes the Terminal Window to be activated.  You should be aware of 
this, although it should not cause any issues.  

Other functionalities remaining to be incorporated in future versions 
• General 

o Making it possible to see handshapes that are not fully visible by hovering over the handshape 
o Making SignStream menus fully available when a window other than the Utterance Window is active 
o Implementation of Cut/Paste/Undo functionality 
o Enabling paste to work in window for file saving 
o Improving the way local information (e.g., about participants, annotators, sign bank) is dealt with 
o Ability to open multiple files/windows simultaneously 
o Ability to have multiple macro units in a single SignStream collection 
o Reconsideration of annotator function, and button for selecting that start and end handshapes are the same or 

different 
o Improving help functions and tooltips 
o Import and export options 
o Ability to deal with sound (for spoken language) 
o Information about the XML format will be provided 
o Additional tools for entry of data about gestures, in both signed and spoken language 
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• Database and Utterance Windows 
o Implementation of “Display Time Period” in both Database and Utterance Windows 
o Addition of buttons to play previous event/entity 
o Restoration of arrow key functionality 

• Morph-Phon and Sign Bank Windows 
o Resolving font display issues – in glosses and in tabs of the Morph-Phon Window 
o Improving the sort order of display of Sign Bank results 
o Enabling search by related English words in the Sign Bank (as is now possible online, at  

https://dai.cs.rutgers.edu/dai/s/dai) 
o Enabling more complete information about handshapes to be entered from the Sign Bank into the Morph-Phon 

Window when the sign is associated with more than a start and end handshape (i.e., for loan signs) 
o Enabling deletion of an entry in local Sign Bank 

• Search Window 
o Ability to repeat a search on a different collection and to save and re-open searches 
o Adding some keyboard shortcuts to the Search Window (esp. so that Carriage Return launches the search) 

• Audio 
o Ability to deal with audio files 

Additional Documentation  
Please see the following reports from the American Sign Language Linguistic Research Project (ASLLRP) at Boston 
University: 

  A User's Guide to SignStream® 3 Report No. 15    Neidle, Carol (August 2017) [pdf - 24 MB], 
http://www.bu.edu/asllrp/SignStream/3/SS_User-guide.pdf  

  What's New in SignStream® 3.1.0?  Report No. 16    Neidle, Carol (May 2018) [pdf - 14 MB] 
http://www.bu.edu/asllrp/SignStream/3/SS_update.pdf  

  What's New in SignStream® 3.3.0?   Report No. 17    Neidle, Carol (2020) [pdf - 14 MB] 
http://www.bu.edu/asllrp/SignStream/3/SS_update-3_3.pdf 

  What's New in SignStream® 3.4.0?   Report No. 22    Neidle, Carol (2022) [pdf – 1.6 MB] 
http://www.bu.edu/asllrp/rpt22/asllrp22.pdf  

  What's New in SignStream® 3.4.1?   Report No. 23    Neidle, Carol (2023) [pdf – 1 MB] 
https://www.bu.edu/asllrp/rpt23/asllrp23.pdf  

For information about our online, SignStream-annotated, video corpora shared through our Data Access Interface 
and about the ASLLRP Sign Bank, see the following, as well as the references in the next section: 

  Neidle, Carol, and Augustine Opoku (2020)  A User's Guide to the American Sign Language Linguistic Research 
Project (ASLLRP) Data Access Interface (DAI) 2 — Version 2. Boston University, ASLLRP Project Report No. 18 
http://www.bu.edu/asllrp/rpt18/asllrp18.pdf 

Neidle, Carol, and Augustine Opoku (2021)  Update on Linguistically Annotated ASL Video Data Available through 
the American Sign Language Linguistic Research Project (ASLLRP). Boston University, ASLLRP Project Report 
No. 19  https://www.bu.edu/asllrp/rpt19/asllrp19.pdf 

Neidle, Carol, Augustine Opoku, and Dimitris Metaxas (2022)  ASL Video Corpora & Sign Bank: Resources Available 
through the American Sign Language Linguistic Research Project (ASLLRP). arXiv:2201.07899. 
https://arxiv.org/abs/2201.07899  
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Neidle, Carol, Augustine Opoku, Carey Ballard, Konstantinos M. Dafnis, Evgenia Chroni, and Dimitris Metaxas 
(2022)  Resources for Computer-Based Sign Recognition from Video, and the Criticality of Consistency of Gloss 
Labeling across Multiple Large ASL Video Corpora. 10th Workshop on the Representation and Processing of 
Sign Languages: Multilingual Sign Language Resources. LREC, Marseille, France. European Language 
Resources Association (ELRA).  BU Open Access: https://hdl.handle.net/2144/45152 
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Appendix:  New Gesture Mode  
 
In consultation with gesture researchers, we have now included a new “Gesture Mode” in SignStream.  It is 
possible to display the gesture-specific fields in addition to, or instead of, Sign fields and Nonmanual fields. 
Display options are selectable from the View menu; see Figure 16.1 
 

 

Figure 16. Selecting View Modes 

This section describes how Gesture Mode works. 
To create a new gesture, Control-Click and drag in the dom gesture or ndom gesture field.  By default, the 

gesture will initially be labelled as “STROKE,” optionally followed by a numerical identifier, so that gestures can 
be uniquely identified.  However, double-clicking on that label opens the Gesture Info Window, shown in Figure 
17, where this can be edited. 

 

Figure 17. Gesture Info Window 

You can enter whatever label you want for the gesture, and decide whether you want to have unique numbers 
for gestures in the SignStream collection or not.  You can enter whether it is 1-handed or 2-handed, and then 
enter information about handshapes. It is possible to check “incomplete” there for a gesture that is started 
but not completed.  “Select handshapes” opens the window shown in Figure 18. 
  

 
1 Furthermore, if the user chooses to display two different segment tiers, with different participants, in the 
Utterance Window, the view display can be different in the two parts of the window.  For example, one could 
display Sign Fields for one participant and Gesture Fields for the other. 
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Figure 18. Window for Selection of Handshapes and Corresponding  Orientations 

Multiple handshape palettes are available to be displayed (all of those available for sign annotation plus an 
additional palette corresponding to a set of handshapes deemed useful specifically for gesture research).  
 
 
  
 

Figure 19. Available Handshape Palettes 

In addition, each handshape that is entered can be associated with distinct orientations – fingertip orientation 
and/or palm orientation (although these need not be specified; “do not include” is an option).  These options 
are displayed beneath the handshape options and align with handshapes.   
 

Selected information, shown at the bottom of Figure 18, is then entered into the Gesture Info Window, 
as shown in Figure 20. 
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Figure 20. Handshape and Orientation Information entered into the Gesture Info Window 

This information can then be entered into the Utterance Window, as shown below. 
 

 

Figure 21. Gesture Information entered into the Utterance Window 

Location Information can be entered from the Location tab in the Gesture Info Window.   

 

Figure 22. Tabs available from the Gesture Info Window 
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The Location Information Window is shown in Figure 24. Location (place of articulation) is entered by clicking 
on the Select Location button in  Figure 24. This occurs in 2 stages, via selections of body regions, as illustrated 
in Figure 23. 
 

 

           

Figure 23. Selection of Location Information, in 2 Stages 

 
Locations can be entered for dominant and non-dominant start and end points of the gesture, but a given 
selected location can also be quickly copied to other positions, as shown in Figure 24. 
 

 

 
Figure 24. Location Information Window 
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Location information can then be entered into the Utterance Window: 
 

 

Figure 25. Display of Gesture Information in the Utterance Window 

 
From the Gesture Properties tab in the Gesture Info Window (see Figure 22), any of a large variety of 

properties, include movement types, semantic/pragmatic functions, and other properties, can also be selected, 
in any combination, as shown in Figure 26 (spread over the next 3 pages). 
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Continued on next page 



 21 

 

 

 

Continued on next page 
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Figure 26. Selection of Gesture Properties 

For example, this will be displayed as in Figure 27. 
 

 

Figure 27. Display of Gesture Information in the Utterance Window 
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Figure 28 shows the display of all 3 regions – nonmanual, sign, and gesture.  The Field Editor (the green 
cross icon) opens a window (shown in Figure 29) that allows you to explicitly show or hide any of the field 
options within each section.  By default, the basic fields, plus others that are non-empty, will be displayed. 

 

 

   
 

Figure 28. Field Selector Button -- with display of All Three Data Types 

 

Field 
Editor 
button 
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Figure 29. Field Selection Options (partial view) 

 
It is also possible to select, on the right, which field should be used for the display of the left index.  For 

example, that could be displayed based on sign glosses on the dominant hand (which is the default in Sign 
Mode), or on dominant gesture labels. 
 

When entering gestures, it is possible to append information about phases to the core gesture event (just 
as it is possible in Sign Mode to append initial and/or final holds, onsets, and offsets to an event), and it is also 
possible to mark the apex of the gesture, as shown in Figure 32. 

 

 
 

 

Figure 30. Gesture Phases 
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Preparation | Pre-stroke hold                                                                         Post-stroke hold | Retraction | Relaxed 
 

Figure 31. Display of Gesture Phases in the Utterance Window 

 

 
Figure 32. Optional Marking of the Apex of the Gesture in the  Utterance Window 

The new gesture fields are also searchable, as shown in Figure 33. 
 

 
 

Figure 33. Search Window: Gesture Fields are also searchable 
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